SCXI"

SCXI-1600 User Manual

USB 16-Bit Digitizer Module

‘YNATIONAL September 2004 Edition
’ INSTRUMENTS' Part Number 373364C-01



Worldwide Technical Support and Product Information

ni.com

National Instruments Corporate Headquarters
11500 North Mopac Expressway Austin, Texas 78759-3504 USA Tel: 512 683 0100

Worldwide Offices

Australia 1800 300 800, Austria 43 0 662 45 79 90 0, Belgium 32 02 757 00 20, Brazil 55 11 3262 3599,
Canada (Calgary) 403 274 9391, Canada (Ottawa) 613 233 5949, Canada (Québec) 450 510 3055,

Canada (Toronto) 905 785 0085, Canada (Vancouver) 604 685 7530, China 86 21 6555 7838,

Czech Republic 420 224 235 774, Denmark 45 45 76 26 00, Finland 385 09 725 725 11,

France 33 0 1 48 14 24 24, Germany 49 0 89 741 31 30, India 91 80 51190000, Israel 972 0 3 6393737,
Italy 39 02 413091, Japan 81 3 5472 2970, Korea 82 02 3451 3400, Malaysia 603 9131 0918,

Mexico 01 800 010 0793, Netherlands 31 0 348 433 466, New Zealand 0800 553 322, Norway 47 0 66 90 76 60,
Poland 48 22 3390150, Portugal 351 210 311 210, Russia 7 095 783 68 51, Singapore 65 6226 5886,
Slovenia 386 3 425 4200, South Africa 27 0 11 805 8197, Spain 34 91 640 0085, Sweden 46 0 8 587 895 00,
Switzerland 41 56 200 51 51, Taiwan 886 2 2528 7227, Thailand 662 992 7519,

United Kingdom 44 0 1635 523545

For further support information, refer to the Signal Conditioning Technical Support Information document.
To comment on National Instruments documentation, refer to the National Instruments Web site at

ni.com/info and enter the info code feedback.

© 2004 National Instruments Corporation. All rights reserved.



Important Information

Warranty

The SCXI-1600 is warranted against defects in materials and workmanship for a period of one year from the date of shipment, as evidenced
by receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves to be defective during the
warranty period. This warranty includes parts and labor.

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects
in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National
Instruments will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives
notice of such defects during the warranty period. National Instruments does not warrant that the operation of the software shall be
uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before
any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are
covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical
accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent
editions of this document without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected.
In no event shall National Instruments be liable for any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF
NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR
DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY
THEREOF. This limitation of the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including
negligence. Any action against National Instruments must be brought within one year after the cause of action accrues. National Instruments
shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein does not cover
damages, defects, malfunctions, or service failures caused by owner’s failure to follow the National Instruments installation, operation, or
maintenance instructions; owner’s modification of the product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire,
flood, accident, actions of third parties, or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying,

recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National
Instruments Corporation.

Trademarks

CVI™, DAQ-STC™, LabVIEW"™, Measurement Studio"™, National Instruments™, NI"™, ni.com™, NI-DAQ"™, and SCXI"™ are trademarks of
National Instruments Corporation.

Product and company names mentioned herein are trademarks or trade names of their respective companies.

Patents

For patents covering National Instruments products, refer to the appropriate location: Help»Patents in your software, the patents. txt file
on your CD, or ni.com/patents.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS

(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF
RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN
ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT
INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE
IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY,
COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS
AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND
HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL
DEVICES, TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR
MISUSES, OR ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE
HEREAFTER COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD
CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD
NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID
DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO
PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS.
BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS' TESTING
PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN
COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT EVALUATED OR CONTEMPLATED BY NATIONAL
INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING
THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE
INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN,
PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.



Conventions

<>

»

> &

bold

italic

monospace

The following conventions are used in this manual:
Angle brackets contain values associated with a bit or signal name.

The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash. When this icon is marked on the
product, refer to the Read Me First: Safety and Radio-Frequency
Interference document, shipped with the product, for precautions to take.

When symbol is marked on a product it denotes a warning advising you to
take precautions to avoid electrical shock.

When symbol is marked on a product it denotes a component that may be
hot. Touching this component may result in bodily injury.

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names.

Italic text denotes variables, emphasis, a cross reference, hardware labels,
or an introduction to a key concept. This font also denotes text that is a
placeholder for a word or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.
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About the SCXI-1600

This chapter introduces the SCXI-1600 USB digitizer module. The
SCXI-1600 module is a high-performance plug-and-play USB device used
for direct connection between USB-compatible computers and SCXI
systems.

The SCXI-1600 module is a USB data acquisition (DAQ) device that
features a 16-bit ADC. The SCXI-1600 receives analog signals from other
SCXI modules and amplifies, digitizes, and sends data through a USB port.
The SCXI-1600 can also control digital input, digital output, and analog
output SCXI modules. The SCXI-1600 has no DIP switches, jumpers,

or potentiometers. It is easily configured and calibrated using software.

The SCXI-1600 connects to other SCXI modules to acquire up to

352 analog signals from thermocouples, RTDs, strain gauges, voltage
sources, and current sources. It is USB compatible, which supports hot
or powered insertion into the USB port. You need not power down the
computer to connect to an SCXI system.

A Caution SCXI modules are not hot swappable. Refer to the Installing the SCXI-1600
section for proper installation instructions.

The SCXI-1600 module is based on E Series DAQ devices and uses the
National Instruments DAQ-STC system timing controller for time-related
functions. The DAQ-STC makes possible such applications as equivalent
time sampling, and seamlessly changing the sampling rate. The DAQ-STC
consists of three timing groups that control analog input.

Detailed specifications of the SCXI-1600 module are in Appendix A,
Specifications.

© National Instruments Corporation 1-1 SCXI-1600 User Manual



Chapter 1 About the SCXI-1600

What You Need to Get Started

To set up and use the SCXI-1600 module, you need the following:

a

5

a

SCXI-1600 User Manual

Hardware

—  SCXI-1600 module (supplied with a USB cable)

— Analog-input, analog-output, or digital I/O SCXI module
—  SCXI chassis

—  Personal computer or a PXI controller with a USB port

—  Cabling, cable adapter, and sensors as required for your
application

Note The SCXI-1600 is not compatible with the PXI/SCXI combination chassis.

Software
— NI-DAQ 7.3 or later
—  One of the following:
e LabVIEW
«  LabWindows"/CVI"™

Documentation

—  SCXI-1600 User Manual

—  DAQ Quick Start Guide

—  SCXI Quick Start Guide

—  Read Me First: Safety and Radio-Frequency Interference

—  Documentation for your software

1-2 ni.com



Chapter 1 About the SCXI-1600

National Instruments Documentation

The SCXI-1600 User Manual is one piece of the documentation set

for DAQ systems. You could have any of several types of documents,
depending on the hardware and software in the system. Use the documents
you have as follows:

The DAQ Quick Start Guide—This document describes how to install
NI-DAQ devices and NI-DAQ. You must install NI-DAQ before you
install the SCXI module.

The SCXI Quick Start Guide—This document describes how to set up
an SCXI chassis, install SCXI modules and terminal blocks, and
configure the SCXI system in Measurement & Automation Explorer
(MAX).

Getting Started with SCXI—Read this manual first. It gives an
overview of the SCXI system and contains the most commonly needed
information for the modules, chassis, and software.

SCXI chassis manual—This manual contains installation instructions
and maintenance information about the chassis.

The SCXI hardware user manuals—Read these manuals next

for detailed information about signal connections and module
configuration. They also explain, in greater detail, how the module
works and contain application hints.

Accessory installation guides or manuals—If you are using accessory
products, read the terminal block and cable assembly installation
guides. They explain how to physically connect the relevant pieces
of the system. Consult these guides when you are making the
connections.

Software documentation—You may have both application software
and NI-DAQ software documentation. NI application software
includes LabVIEW, LabWindows/CVI1, and Measurement Studio.
After you set up the hardware system, use either your application
software documentation or the NI-DAQ documentation to help you
write your application. If you have a large, complex system, it is
worthwhile to look through the software documentation before

you configure the hardware. Refer to Start»Programs»National
Instruments»NI-DAQ»NI-DAQmx Help for software information.

You can download NI documents from ni.com/manuals.

© National Instruments Corporation

1-3 SCXI-1600 User Manual



Chapter 1 About the SCXI-1600

Installing the Application Software, NI-DAQmx, and the

DAQ Device

Refer to the DAQ Quick Start Guide, packaged with the NI-DAQ software,
to install your application software and NI-DAQmx driver software.

NI-DAQmx 7.3 or later is required to configure and program the
SCXI-1600 module. If you do not have NI-DAQmx 7.3 or later, you can
either contact an NI sales representative to request it on a CD or download
the latest NI-DAQmx version from ni . com/downloads.

Installing the SCXI-1600

@ Note Refer to the Read Me First: Radio-Frequency Interference document before
removing equipment covers or connecting or disconnecting any signal wires.

Refer to the SCXI Quick Start Guide to unpack, install, and configure the

SCXI-1600 in an SCXI chassis. After installing the SCXI-1600, power on
the SCXI chassis. The computer should detect the SCXI chassis and all its
modules. If the SCXI-1600 does not initialize properly, you must restart the
SCXI chassis with the power on switch.

LED Pattern Descriptions

SCXI-1600 User Manual

There are four LEDs on the front of the SCXI-1600 that confirm the signal
conditioning system is functioning properly as follows:

e The top two green LEDs, which monitor the V+ and V- rails of
the SCXI chassis backplane, must be bright green for the signal
conditioning system to function properly. If either or both the V+ or
V— green LEDs is off, check the SCXI chassis backplane fuses and
replace any bad fuses as described in the SCXI Chassis User Manual.

*  The bottom two LEDs, the yellow ACTIVE LED and green READY
LED, indicate the state of the SCXI-1600 USB. If the READY LED is
bright green, the SCXI-1600 is powered, connected to the host, and is
configured properly. Refer to Table 1-1 for LED pattern descriptions.

1-4 ni.com



Chapter 1 About the SCXI-1600

Table 1-1. LED Patterns for SCXI-1600 USB States

ACTIVE READY
Yellow LED | Green LED Description
Off Off The SCXI-1600 is not powered.
Off On The SCXI-1600 is configured, but there is no activity over the bus.
On On The SCXI-1600 is configured and there is activity over the bus.
Blinking On
Off Blinking The SCXI-1600 is being configured, but there is no activity over
the bus.
On Blinking The SCXI-1600 is being configured and there is activity over
. . the bus.
Blinking Blinking
Blinking continuously This indicates a recoverable error state in the SCXI-1600. You can
power off the module, or detach and reattach the USB cable to reset
the module.
Blinking alternately This indicates an unrecoverable error in the SCXI-1600. Refer to
the Signal Conditioning Technical Support Information document
to contact NI for support.

© National Instruments Corporation

1-5 SCXI-1600 User Manual



Connecting Signals

This chapter describes how to make input and output signal connections to
the SCXI-1600 module using the device I/O connectors. The following
connector types are located on the front panel:

¢ Three BNC connectors—These connectors are used to access
PFI 0/AI START TRIG and PFI 7/A1 SAMP CLK, and to perform
external calibration. For calibration information refer to Chapter 4,
Using the SCXI-1600.

*  USB connector—This connector is used to communicate and transfer
data between the computer and SCXI-1600 module. Figure 2-1
illustrates the connection requirements.

XY

Figure 2-1. Cable between the SCXI-1600 and the Computer USB Port or USB Hub

Figure 2-2 shows the SCXI-1600 connectors.

© National Instruments Corporation 2-1 SCXI-1600 User Manual



Chapter 2

Connecting Signals
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Figure 2-2. SCXI-1600 Module Front Panel Connectors
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Connecting Signals

Chapter 2 Connecting Signals

This section describes the SCXI-1600 I/O signals.

I/0 Connector Signal Descriptions

Table 2-1. 1/0 Connector Signal Descriptions

Signal Name

Reference Direction

Description

PFI 0/AI START TRIG

D GND Input PFI O/Trigger 1—As an input, this is
either one of the PFIs or the source for
the hardware digital trigger. PFI signals
are explained in Appendix B, Timing
Signal Information.

Output As an output, this is the AT START
TRIG signal. In posttrigger data
acquisition sequences, a low-to-high
transition indicates the initiation of the
acquisition sequence. In pretrigger
applications, a low-to-high transition
indicates the initiation of the pretrigger
conversions.

PFI 7/SAMP CLK

D GND Input PFI 7/Start of scan—As an input, this is
one of the PFIs.

Output As an output, this is the SAMP CLK
signal. This pin pulses once at the start
of each analog input scan in the interval
scan. A low-to-high transition indicates
the start of the scan.

EXT CAL

AI GND Input External calibration—This input is
used for external calibration of the
SCXI-1600. The DC source must be
more accurate than 10 ppm.

© National Instruments Corporation
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Chapter 2

AN\

Connecting Signals

Table 2-2 shows the I/0 signal summary for the SCXI-1600 module.

Caution Exceeding the maximum input voltage ratings, which are listed in Table 2-2,

can damage the SCXI-1600 module and the computer. NI is not liable for any damages
resulting from such signal connections.

Table 2-2. 1/0 Signal Summary

Protection
(Volts) Source Sink Rise
Signal Name Drive On/Off (mA at V) | (mA atV) | Time (ns) Bias

PFI 0/ DIO 24V 3.5 at 5at0.4 1.5 50 kQ pu
AI START TRIG (Ve —0.4)

PF1 7/ DIO 24V 3.5 at 5at0.4 1.5 50 kQ pu
AI SAMP CLK (Ve —0.4)

EXT CAL Al 24V — — — —

Al = analog input
DIO = digital input/output
pu = pullup

and 100 kQ.

Note: The tolerance on the 50 kQ pullup and pulldown resistors is very large. Actual values can range between 17 kQ

Notes

The SCXI-1600 controls the SCXI system and digitizes analog signals
from the other modules in the system and has no configurable settings. For
information about configuring other modules in the system, refer to the
module user manuals and the SCXI Quick Start Guide.

The SCXI-1600 operates in multiplexed mode only.

The SCXI-1600 has no Test Panels in MAX and is grayed out. You can perform Test
Chassis to verify the presence of the SCXI-1600.

SCXI-1600 User Manual
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Chapter 2 Connecting Signals

Field Wiring Considerations

Environmental noise can seriously affect the accuracy of measurements
made with the SCXI system if you do not take proper precautions when
running signal wires between signal sources and the module. The following
recommendations apply mainly to analog input signal routing, but they also
apply to signal routing in general.

Take the following precautions to minimize noise pickup and maximize
measurement accuracy:

»  For the external calibration signals, make connections using
individually shielded, twisted-pair wires. With this type of wire, the
signals attached to the CH+ and CH- inputs are twisted together and
then covered with a shield. You then connect this shield only at one
point to the signal source ground. This kind of connection is required
for signals traveling through areas with large magnetic fields or high
electromagnetic interference.

* Route signals to the device carefully. Keep cabling away from noise
sources. The most common noise source in a computer DAQ system is
the video monitor. Separate the monitor from the analog signals as
much as possible.

The following recommendations apply to all signal connections to the
SCXI-1600 module:

»  Separate SCXI-1600 module signal lines from high-current or
high-voltage lines. These lines are capable of inducing currents in or
voltages on the SCXI-1600 module signal lines if they run in parallel
paths at a close distance. To reduce the magnetic coupling between
lines that run in parallel, separate them as much as possible or run the
lines perpendicular to each other.

* Do not run signal lines through conduits that also contain power lines.

*  Protect signal lines from magnetic fields caused by electric motors,
welding equipment, breakers, or transformers by running them through
special metal conduits.

For more information, refer to the Field Wiring and Noise Consideration
for Analog Signals application note, available at ni . com.

© National Instruments Corporation 2-5 SCXI-1600 User Manual



Theory of Operation

This chapter discusses the theory of operational measurement concepts.

Figure 3-1 shows the block diagram for the SCXI-1600 module.

EXT
CAL

Analog Analog

. | AaD ADC
Input Multiplexer 9| PGA Converter FIFO

v

usB
Interface

Configuration
Memory

DAQ-APE
SCXIBus Digital I/0
Timing DAQ-STC PFI/Trigger PFI Lines

Figure 3-1. SCXI-1600 Module Block Diagram

Analog Input

When setting up an SCXI system using the SCXI-1600 module, follow the
analog input setup instructions of the input SCXI modules. The input mode
on the SCXI-1600 does not affect the input used on the analog input

© National Instruments Corporation 3-1 SCXI-1600 User Manual



Chapter 3 Theory of Operation

Input Mode

modules. The detailed analog input descriptions of the digitizer provide
information regarding the functionality of the SCXI-1600.

The analog input portion of the board acquires analog signals from the
SCXI chassis backplane and prepares the signal for digital conversion.
The type of input, the input range, and the software configurable gain of
the SCXI-1600 are described in detail in the following sections.

The SCXI-1600 module input mode is differential (DIFF). A channel
configured in DIFF mode connects the positive analog input line to the
positive input of the PGIA and the negative analog input line to the negative
input of the PGIA. Specifically, all the analog input channels coming from
the input SCXI modules are multiplexed to analog channel 0 on the SCXI
backplane. The signals are then accepted into the SCXI-1600.

Input Polarity, Input Range, and Gain

The SCXI-1600 module has a software-programmable gain to obtain the
highest level of precision. It matches the input signal range to a range the
ADC can accommodate using the gains available. Specifically, the
SCXI-1600 has a bipolar input range of 10 V (=5 V) and gains of 0.5, 1, 10,
and 100. With the proper gain, which is set by the driver software, the full
resolution of the ADC is used to measure the input signal. The gain on the
signals are set using the gain on the SCXI analog input module multiplied
with the gain on the SCXI-1600. Table 3-1 shows the overall input range
and precision of the SCXI-1600 according to the input range configuration
and gain used.

Table 3-1. Actual Range and Measurement Precision

Range Configuration Gain Actual Input Range Precision'
Sto+5V 0.5 -10to +10 V 305.2 uv
1.0 Sto+5V 152.6 uv
10.0 —500 to +500 mV 15.26 uv
100.00 50 to +50 mV 1.53 uv

ADC 16-bit count.

' The value of 1 LSB of the 16-bit ADC; that is, the voltage increment corresponding to a change of one count in the

Note: Refer to Appendix A, Specifications, for absolute maximum ratings.
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Considerations for Selecting Input Ranges of an SCXI System

The range that you select depends on the expected range of the incoming
signal. A large input range can accommodate a large signal variation, but
reduces the voltage resolution. Choosing a smaller input range improves
the voltage resolution, but can result in the input signal going out of range.
For best results, match the input range as closely as possible to the expected
range of the input signal. For example, if you are certain the input signal is
between +50 mV, specify this range. If the signal is less than —50 mV or
greater than 50 mV, inaccurate readings occur.

Calculating the Maximum Scan Rate

The SCXI-1600 module can scan multiple channels at a high rate. To
calculate the maximum permitted scan rate when using one or more SCXI
modules in multiplexed mode, use the following:

1
(5 us X number of channels scanned)

maximum permitted scan rate =

In this equation, the term (number of channels scanned) is the number of
all the channels scanned in a chassis.

Scanning Considerations

The settling time for the SCXI-1600 module is independent of the selected
gain. With the SCXI-1600, the gain is constant and the source impedance
is low. Refer to Appendix A, Specifications, for a complete listing of
settling times for the SCXI-1600 module.

The low source impedance of the SCXI-1600 module keeps the settling
time low. Settling times can increase when scanning high-impedance
signals due to a phenomenon called charge injection, where the analog
input multiplexer injects a small amount of charge into each signal source
when that source is selected. If the source impedance is not low enough, the
effect of the charge—a voltage error—does not decay by the time the ADC
samples the signal.
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Timing Signal Routing

The DAQ-STC provides a very flexible interface for connecting timing
signals to other devices or external circuitry. The SCXI-1600 module uses
two programmable function input (PFI) pins on the I/O connector for
connecting to external circuitry. These connections enable the SCXI-1600
to control and be controlled by other devices and circuits.

You can control a total of 13 timing signals internal to the DAQ-STC by
an external source. You also can control these timing signals by signals
generated internally to the DAQ-STC. These selections are fully software
configurable. The signal routing multiplexer for controlling the

AI CONV CLK signal on the SCXI-1600 is shown in Figure 3-2.

PFIO —

PFI 7 —» —» Al CONV CLK

Sample Interval Counter TC ——P>|

Figure 3-2. Al CONV CLK Signal Routing

Figure 3-2 shows that the Al CONV CLK signal is generated from sources
including the external signals PFI <0, 7> and the internal signal sample
interval counter TC.
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Programmable Function Inputs

The two PFIs connect to the signal routing multiplexer for each timing
signal, and software can select one of the PFIs as the external source for
a given timing signal. You can use the two PFIs as an input by any of
the timing signals, and multiple timing signals can use the same PFI
simultaneously. This flexible routing scheme reduces the need to change
physical connections to the I/O connector for different applications.

You also can enable each of the PFI pins individually to output a specific
internal timing signal. For example, if you need the Al SAMP CLK signal
as an output on the I/O connector, software can power on the output driver
for the PFI 7/A1 SAMP CLK pin.

Multiplexed Operation

The SCXI-1600 operates in multiplexed mode, digitizing the conditioned
signals from other SCXI modules and communicating with the host
through the USB port.

In multiplexed mode, all input channels of an SCXI module are multiplexed
into a single analog input channel of the DAQ device. Multiplexed mode
operation is ideal for high channel count systems. The power of SCXI
multiplexed mode scanning is its ability to route many input channels

to a single channel of the SCXI-1600.

The multiplexing operation of the analog input signals is performed
entirely by multiplexers in the SCXI modules, not inside the SCXI-1600 or
SCXI chassis. In multiplexed mode, the SCXI module channels you are
scanning are kept by the NI-DAQ driver in a scan list. Immediately prior to
a multiplexed scanning operation, the SCXI chassis is programmed with a
module scan list that controls which module sends its output to the
SCXIbus during a scan to the SCXI-1600.

The list can contain channels in any physical order, and the multiplexer can
sequence the channel selection from the scan list in any order. The ordering
of scanned channels need not be sequential. Channels can occur multiple
times in a single scan list. The scan list can contain an arbitrary number of
channels for each module entry in the scan list, limited to a total of

352 channels per SCXI-1600. This is referred to as flexible scanning
(random scanning). Not all SCXI modules provide flexible scanning.
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SCXI-1600 User Manual

The analog input modules include first-in first-out (FIFO) memory for
storing the channel scan list defined in your application code. NI-DAQ
drivers load the FIFO based on the channel assignments you make in your
application. You need not explicitly program the module FIFO, as this is
done automatically for you by the NI-DAQ driver.
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This chapter describes how to develop your application and provides basic
information about calibration.

Developing Your Application in NI-DAQmx

This section describes how to configure and use NI-DAQmzx to control the
SCXI-1600 in LabVIEW, LabWindows/CVI, and Measurement Studio.
These ADEs provide greater flexibility and access to more settings than
MAX, but you can use ADEs in conjunction with MAX to quickly create a
customized application. Refer to the SCXI Quick Start Guide for general
SCXI configuration information.

E Note If you are not using an NI ADE, using an NI ADE prior to version 7.0, or using an
unlicensed copy of an NI ADE, additional dialog boxes from the NI License Manager
appear allowing you to create a task or global channel in unlicensed mode. These messages
continue to appear until you install version 7.0 or later of an NI ADE.

Typical Program Flowchart

Figure 4-1 shows a typical program flowchart for creating a task to
configure the SCXI-1600 channels, take a measurement, analyze the
data, present the data, stop the measurement, and clear the task.
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Yes Create Task Using No
v DAQ Assistant? +

Create a Task
Programmatically

I—,+

Create Task in

DAQ Assistant
or MAX Create Another ‘ Create Custom
Channel? Channel
\ A

Hardware

imi i ing?
Further Configure A Timing/Triggering?
Channels?
Adjust Timing Settings
Configure Channels
Y
Analyze Data?
\4
Process
Start Measurement Data
Yes Display Data?
A 4 Graphical
Display Tools

Read Measurement

+ Yes

Continue Sampling?

Stop Measurement

\ 4
Clear Task

Figure 4-1. Typical Program Flowchart
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General Discussion of Typical Flow-Chart

The following sections briefly discuss some considerations for a few of the
steps in Figure 4-1. These sections are meant to give an overview of some
of the options and features available when programming with NI-DAQmx.

Creating a Task Using the DAQ Assistant or
Programmatically

When creating an application, you first must decide whether to create the
appropriate task using the DAQ Assistant or programmatically in the ADE.

Developing your application using the DAQ Assistant allows you to
configure most settings such as measurement type, selection of channels,
signal input limits, task timing, and task triggering. You can access the
DAQ Assistant through MAX or your NI ADE. Choosing to use the
DAQ Assistant can simplify the development of your application.

NI recommends creating tasks using the DAQ Assistant for ease of use,
when using a sensor that requires complex scaling, or when many
properties differ between channels in the same task.

If you are using an ADE other than an NI ADE, or if you want to explicitly
create and configure a task for a certain type of acquisition, you can
programmatically create the task from your ADE using functions or VIs.
If you create a task using the DAQ Assistant, you can still further configure
the individual properties of the task programmatically with functions or
property nodes in your ADE. NI recommends creating a task
programmatically if you need explicit control of programmatically
adjustable properties of the DAQ system.

Each API includes a collection of programming examples to help you start
developing an application. You can modify example code and save it in an
application. You can use examples to develop a new application or add
example code to an existing application.

To locate LabVIEW and LabWindows/CVI examples, open the National
Instruments Example Finder:
* InLabVIEW, select Help»Find Examples.

* In LabWindows/CVI, select Help»NI Example Finder.
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Measurement Studio, Visual Basic, and ANSI C examples are in the
following directories:

*  NI-DAQmx examples for Measurement Studio supported languages
are in the following directories:

— MeasurementStudio\VCNET\Examples\NIDag
— MeasurementStudio\DotNET\Examples\NIDaqg

*  NI-DAQmx examples for ANSI C are in the NI-DAQ\Examples\
DAQmx ANSI C Dev directory.

For additional examples, refer to ni . com/zone.

Programmatically adjusting properties for a task created in the

DAQ Assistant overrides the original, or default, settings only for that
session. The changes are not saved to the task configuration. The next time
you load the task, the task uses the settings originally configured in the
DAQ Assistant.

Adjusting Timing and Triggering

There are several timing properties that you can configure through the
DAQ Assistant or programmatically using function calls or property nodes.
If you create a task in the DAQ Assistant, you can still modify the timing
properties of the task programmatically in your application.

When programmatically adjusting timing settings, you can set the task to
acquire continuously, acquire a buffer of samples, or acquire one point at a
time. For continuous acquisition, you must use a While Loop around the
acquisition components even if you configured the task for continuous
acquisition using MAX or the DAQ Assistant. For continuous and buffered
acquisitions, you can set the acquisition rate and the number of samples to
read in the DAQ Assistant or programmatically in your application. By
default, the clock settings are automatically set by an internal clock based
on the requested sample rate. You also can select advanced features such as
clock settings that specify an external clock source, internal routing of the
clock source, or select the active edge of the clock signal.
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Configuring Channel Properties

All ADEs used to configure the SCXI-1600 access an underlying set of
NI-DAQmzx properties. For a complete list of NI-DAQmx properties, refer
to your ADE help file. For LabVIEW specifically, refer to Help» VI,
Function & How-To Help and search for your specific module to find the
DAQmzx channel properties available for you module. To learn how to use
the channel properties, refer to the Using a DAQmx Channel Property Node
in LabVIEW section.

E Note You cannot adjust some properties while a task is running. For these properties,
you must stop the task, make the adjustment, and restart the application.

Acquiring, Analyzing, and Presenting

After configuring the task and channels, you can start the acquisition, read
measurements, analyze the data returned, and display it according to the
needs of your application. Typical methods of analysis include digital
filtering, averaging data, performing harmonic analysis, applying a custom
scale, or adjusting measurements mathematically.

NI provides powerful analysis toolsets for each NI ADE to help you
perform advanced analysis on the data without requiring you to have a
programming background. After you acquire the data and perform any
required analysis, it is useful to display the data in a graphical form or log
it to a file. NI ADEs provide easy to use tools for graphical display, such as
charts, graphs, slide controls, and gauge indicators. NI ADEs have tools
that allow you to easily save the data to files such as spread sheets for easy
viewing, ASCII files for universality, or binary files for smaller file sizes.

Completing the Application

After you have completed the measurement, analysis, and presentation of
the data, it is important to stop and clear the task. This releases any memory
used by the task and frees up the DAQ hardware for use in another task.

Developing an Application Using LabVIEW

This section describes in more detail the steps shown in the typical program
flowchart in Figure 4-1, such as how to create a task in LabVIEW. If you
need more information or instructions, select Help» VI, Function,

& How-To Help from the LabVIEW menu bar.
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@ Note Except where otherwise stated, the VIs in Table 4-1 are located on the Functions»
All Functions»NI Measurements»DAQmx - Data Acquisition subpalette and
accompanying subpalettes in LabVIEW.

Table 4-1. Programming a Task in LabVIEW

Flowchart Step

VI or Program Step

Create a Task in the
DAQ Assistant

Create a Task located on the Functions»Input subpalette
DAQ Assistant.

Create a Task

The DAQmx Create Task VI is optional if you created and configured

Programmatically your task using the DAQ Assistant. However, if you use it in LabVIEW,
(optional) any changes you make to the task are not saved to a task in MAX.
Adjust Timing Settings | The DAQmx Timing VI (Sample Clock by default) is optional if you
(optional) created and configured your task using the DAQ Assistant. Any timing

settings modified with this VI are not saved in the task in the DAQ
Assistant. They are only available for the present session.

Configure Channels
(optional)

DAQmx Channel Property Node, refer to the Using a DAQmx Channel
Property Node in LabVIEW section for more information. This step is
optional if you created and fully configured the channels in your task
using the DAQ Assistant. Any channel modifications made with a
channel property node are not saved in the task in the DAQ Assistant.
They are only available for the present session.

Start Measurement

DAQmx Start Task VI

Read Measurement

DAQmx Read VI

Analyze Data Some examples of data analysis include filtering, scaling, harmonic
analysis, or level checking. Some data analysis tools are located on the
Functions»Signal Analysis subpalette and on the Functions»All
Functions»Analyze subpalette.

Display Data You can use graphical tools such as charts, gauges, and graphs to display

your data. Some display tools are located on the Controls»Numeric
Indicators subpalette and Controls»All Controls»Graph subpalette.

Continue Sampling

For continuous sampling, use a While Loop. If you are using hardware
timing, you also need to set the DAQmx Timing VI sample mode to
Continuous Samples. Right-click the sample mode terminal of the
DAQmx Timing VI and click Create»Constant. Click the box that
appears and select Continuous Samples.
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Table 4-1. Programming a Task in LabVIEW (Continued)

Flowchart Step

VI or Program Step

Stop Measurement
(optional)

The DAQmx Stop Task VI clears the task and automatically stops the
task.

Clear Task

DAQmx Clear Task VI

Using a DAQmx Channel Property Node in LabVIEW

You can use property nodes in LabVIEW to manually configure the
channels. To create a LabVIEW property node, complete the following
steps:

1.

2.
3.
4

Launch LabVIEW.
Create the property node in a new VI or in an existing VI.
Open the block diagram view.

From the Functions toolbox, select All Functions»
NI Measurements»DAQmx - Data Acquisition, and select
DAQmx Channel Property Node.

Left-click inside the Property box and select Active Channels to
specify the channel(s) you want to configure. If you want to configure
several channels with different properties, separate the lists of
properties with another Active Channels box and assign the
appropriate channel to each list of properties.

E Note If you do not use Active Channels, the properties are set on all of the channels in

the task.

© National Instruments Corporation

Right-click ActiveChan and select Add Element. Left-click the new
ActiveChan box. Navigate through the menus and select the property
to define.

Change the property to either read the property or to write a new value.
Right-click the property, go to Change To, and select Write, Read, or
Default Value.
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8. After you have added the property to the property node, right-click
the terminal to change the attributes of the property, add a control,
constant, or indicator.

9. To add another property to the property node, right-click an existing
property and left-click Add Element. To change the new property,
left-click it and select the property you wish to define.

@ Note Refer to the LabVIEW Help for information about property nodes and specific
NI-DAQmx properties.

Specifying Channel Strings in NI-DAQmx

You cannot specify channel strings on the SCXI-1600. Refer to the user
documentation for the hardware and software used in your system to
specify channel strings for other modules in the system.

Developing an Application Using Text-Based ADEs

You can use text-based ADEs such as LabWindows/CVI, Measurement
Studio, Visual Basic, .NET, and C# to create code for using the
SCXI-1600.

LabWindows/CVI

LabWindows/CVI works with the DAQ Assistant in MAX to generate
code for a task. You can then use the appropriate function call to modify
the task. To create a configurable channel or task in LabWindows/CVI,
complete the following steps:

1. Launch LabWindows/CVI.

2. Open a new or existing project.

3. From the menu bar, select Tools»Create/Edit DAQmx Tasks.
4

Choose Create New Task In MAX or Create New Task In Project
to load the DAQ Assistant.

Configure the NI-DAQmx task.
The DAQ Assistant creates the code for the task based on the
parameters you define in MAX and the device defaults. To change

a property of the channel programmatically, use the
DAQmxSetChanAttribute function.

9]

@ Note Refer to the NI LabWindows/CVI Help for more information about creating
NI-DAQmx tasks in LabWindows/CVI and NI-DAQmzx property information.
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Measurement Studio (Visual Basic, .NET, and C#)

You cannot use the create a task capabilities of Visual Basic, .NET, and C#
with the SCXI-1600. Refer to the user documentation for the hardware and
software used in your system to create .NET or C# tasks for other modules
in the system.

Programmable NI-DAQmx Properties

All of the different ADEs that configure the SCXI-1600 access an
underlying set of NI-DAQmx properties. For a complete list of NI-DAQmx
properties, refer to your ADE help file.

Other Application Documentation and Material

Refer to the ADE documentation and the DAQ analog input examples
for your application software for more detailed information about
programming the SCXI modules for scanning in multiplexed mode.

Calibrating the SCXI-1600 System

The SCXI-1600 ships with a calibration certificate and is calibrated at the
factory to the specifications described in Appendix A, Specifications.
Calibration constants are stored inside the calibration EEPROM and
provide software correction values your application development software
uses to correct the measurements for offset errors in the module.

To assure the highest level of accuracy, you must periodically calibrate the
SCXI-1600. Calibrating the module ensures its accuracy.

In the EEPROM, there is a user-modifiable calibration area in addition

to the permanent factory calibration area. The user-modifiable calibration
area allows you to load the CalDACs with values either from the original
factory calibration or from a calibration that you subsequently performed.

Internal Calibration Procedure

The SCXI-1600 incorporates internal calibration paths that allow routing
channel inputs to ground and an onboard reference voltage. NI software
disconnects the channel inputs from the front signal connector and
reconnects the inputs to ground and an onboard reference when performing
an internal calibration. You need not change any input connections for an
internal calibration.
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This internal calibration process, which generally takes less than two
minutes, is the preferred method of assuring accuracy in your application.
Initiate an internal calibration to minimize the effects of any offset and gain
drifts, particularly those due to warming. You must perform the internal
calibration within 24 hours of the measurement to meet the 24 hour
accuracy specifications provided in Appendix A, Specifications.

Immediately after internal calibration, the only significant residual
calibration error could be gain error due to time or temperature drift of the
onboard voltage reference. This error is addressed by external calibration,
which is discussed in the External Calibration section. If you are interested
primarily in relative measurements, you can ignore a small amount of gain
error, and internal calibration should be sufficient.

Internal Calibration Using MAX

Complete the following steps to perform an internal calibration:

1.

2
3.
4.
5

Open MAX.

Expand Devices and Interfaces.
Expand NI-DAQmx Devices.
Right-click SCXI-1600.

Select Self-Calibrate.

The software informs you when the internal calibration is complete and
whether it was successful.

Internal Calibration Using LabVIEW

Complete the following steps to perform an internal calibration of the

SCXI-1600:

1. Open a blank block diagram in LabVIEW.

2. Select Functions»All Functions»NI Measurements»
DAQmx-Data Acquisition»DAQmx Advanced»
DAQmx Calibration»DAQmx Self Calibrate.vi.

3. Double-click the icon to open the DAQmx Self Calibrate.vi Front
Panel.

4. Inthe device in drop-down box, select the device corresponding to the

SCXI-1600 and run the VI.

@ Note The SCXI-1600 takes a few seconds to perform the calibration.

SCXI-1600 User Manual
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After the VI has completed running, the SCXI-1600 has new calibration
constants stored for all gain settings and the module is calibrated.

External Calibration

You can download all available external calibration documents from
ni.com/calibration by clicking Manual Calibration Procedures.
NI recommends you perform an external calibration once a year.

Calibrating the System

After the SCXI-1600 is calibrated, perform a system calibration using the
SCXI-1600 with the SCXT input module in the system to improve accuracy.
This is considered system, or end-to-end, calibration. Follow the
calibration procedures for the SCXI input module.
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Specifications

This appendix lists the specifications of the SCXI-1600 module. These
specifications are typical at 25 °C unless otherwise noted.

Analog Input
Input Characteristics

Type of ADC....cccvvvviiiiieiieieeeeeeeen Successive approximation
ReSOIULION w.evvviiiieieiiiiiiieieeeeeeeeieeeeees 16 bits, 1 in 65,536
Sampling rate ........ccoceeveevirieeneniienienens 200 kS/s
Device Gain Range
0.5 10V
1 5V
10 +500 mV
100 +50 mV
Input coupling ........cceveeevveeneeriieeneennnenn DC
FIFO buffer size.......ccccccoevievenincencne. 4,096 samples
Data transfers ........ccceoeeveveeseneencneenne. USB
Configuration memory Size................... 512 words

Max working voltage
(signal + common mode) .........cccceeeueenne Each input should remain
within £11 V of ground

External calibration overvoltage protection
Powered on ........cccccveiiiiiiininnnn. 25V
Powered off........cccoveniiiiniiie +15V
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Accuracy Information
Absolute Accuracy
Noise + Absolute Relative Accuracy
Nominal % of Reading Quantization (LV) Accuracy Resolution (LV)
Range Temp at Full
at Full Offset Single Drift Scale Single
Scale (V) | 24 Hours | 1 Year (uv) Point Averaged | (%/°C) (mV) Point Averaged
+10 0.0546 0.0588 +1601 +1029 +92 0.0010 7.57 1205 121
+5 0.0146 0.0188 +811 +515 +46 0.0005 1.80 603 60.3
+0.5 0.0546 0.0588 +100 +66 +6 0.0010 0.40 78.4 7.9
+0.05 0.0546 0.0588 +29 +31 +3.0 0.0010 0.061 39.8 4.0
Note: Accuracies are valid for measurements following an internal calibration. Averaged numbers assume dithering and
averaging of 100 single-channel readings. Measurement accuracies are listed for operational temperatures within +1 °C
of internal calibration temperature and +10 °C of external or factory calibration temperature.

SCXI-1600 User Manual

Transfer Characteristics

Integral nonlinearity (INL) ........c.ccceueenee +1.5 LSB typ, £2.0 LSB max
Differential nonlinearity (DNL) ............. +0.5 LSB typ, +3.0 LSB max
No missing COdes........cecueruereeneneeruenens 16 bits
Offset error

Pregain error after calibration.......... +1.0 pV max

Pregain error before calibration....... +28.8 mV max

Postgain error after calibration......... +157 pV max

Gain error (relative to calibration reference)

Postgain error before calibration .....+40 mV max

After calibration (gain = 1)..............

174 ppm of reading max

Before calibration ..........cccccevveenennne 118,900 ppm reading max
Gain # 1 with gain error
adjusted to 0 at gain = 1.......cceoeee. 1200 ppm of reading max

A2

ni.com




Appendix A Specifications

Amplifier Characteristics

Input impedance (normal)! .................... 100 GQ parallel with 100 pF

External calibration BNC input impedance
Normal powered on .........ccccceueneeee. 100 GQ parallel with 100 pF
Powered off2........c.coceveveeeeererennnn. 820 Q
Overload........cccoovvenevicciecicicinene. 820 Q

Input bias current®............cocoevevevevennnnne. +200 pA

Common-mode rejection ratio (CMRR), DC to 60 Hz

Gain Bipolar
0.5,1 85 dB
10, 100 96 dB

Dynamic Characteristics

Bandwidth
Signal Bandwidth
Small (-3 dB) 413 kHz
Large (1% THD) 490 kHz

Settling time for full-scale step
Gain 100......ccoovvvivienieeiienieeieeen +4 LSB, 5 ps typ
Gain 10, 1, 0.5 e 12 LSB, 5 ps max

! The resistance value is taken from the AD829 op amp specification sheet, and is a value much smaller than the mux or other
op amps. The 100 pF is taken from the mux specification sheet and is much larger than the op amps.

2 This value is the input protection resistor in front of the analog input mux.

3 The input bias current is taken from the AD829 op amp specification sheet. This value is much larger than the other op amps.
Since the AD829 is used as a single-ended op amp, the input bias current is the same as the input offset current. Therefore,
offset current is not listed.
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System noise (LSB,,,, including quantization)

Gain LSB, s
0.5,1.0 1.0
10.0 1.3
100 6.6
Stability
Recommended warm-up time................. 15 min

Offset temperature coefficient

Pregain.....o.cooeeveeeiiiieeeeee 120 pv/°C
POStgain ...ccceeveeeniiiiieeieceeeeee +175 pv/°C
Gain temperature coefficient .................. 120 ppm/°C
Triggers
Al triggers
INPUL .o AI START TRIG
AI REF TRIG
AI SAMP CLK
AI CONV CLK
Al GATE
SI SOURCE
OULPUL ...t Al Start Trigger,
Al Sample Clock
External sources.......ccccccceeeeveeeeeeiinneeeennn. PFI <0, 7>
Compatibility .......cceeveereeiineiieiceieene 5 VTTL
ReESPONSE...eeveiiiiieieeiieseeeeceee e Rising or falling edge
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Pulse width......ccccooviiriiiniiniiiieiee 10 ns min in edge-detect mode

Direction Level Min Max

Input Low voltage 0.0V 08V

High voltage 20V 50V

Output Low voltage (I,,; = 5 mA) — 04V
High voltage (I, = 3.5 mA) 435V —

Recommended warm-up time..............
Interval ......cccooeiiiiiiiiiiiiice

External calibration reference..............

Onboard calibration reference

Level oo

Temperature coefficient...............

Long-term stability ........c.ccceeeennee

Power Requirement

Physical

+22 V SUPPLY oo

=22 V SUPPLY ceveeiieieieeeee e

Dimensions

DXHXW) e

I/0O CONNECHOT.....vveeeeeeieeiee e

© National Instruments Corporation A-5

...5.000 V (3.5 mV)

(over full operating temperature,
actual value stored in EEPROM)

+5 ppm/°C max

...=15 ppm/1,000 h

115 mA max

135 mA max

183 cmx 17.3cm x 3.1 cm
(7.21in. X 6.8 in. X 1.2 in.)

3 BNC connectors,
1 USB front connector
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Appendix A Specifications

Maximum Working Voltage

Maximum working voltage refers to the signal voltage plus the
common-mode voltage.

Channel-to-earth ...........cccooereeninnennne 11 V, Installation Category I

Channel-to-channel..........c..cccccceveennenee. 11 V, Installation Category I
Environmental

Operating temperature .............ccecveeveenee 0to 50 °C

Storage temperature..............ccceeueeuenneee —20to 70 °C

Humidity ....oooeveniiiiniiiincniencnicicee 10 to 90% RH, noncondensing

Maximum altitude............cooevvvvvviinnnnnnnnne 2,000 m

Pollution Degree (indoor use only) ........ 2

Safety

The SCXI-1600 is designed to meet the requirements of the following
standards of safety for electrical equipment for measurement, control,
and laboratory use:

« JEC61010-1, EN 61010-1
« UL 61010-1
« CAN/CSA C22.2 No. 61010-1

@ Note For UL and other safety certifications, refer to the product label or visit
ni.com/certification, search by model number or product line, and click the
appropriate link in the Certification column.
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Electromagnetic Compatibility

EMISSIONS ...cooovvvvvieiiiiieeiee e EN 55011 Class A at 10 m
FCC Part 15A above 1 GHz

IMmUunity ....oooveeveeiniiieeeeee EN 61326:1997 + A2:2001,
Table 1
EMC/EMI.......oovvviiiiiiiiiieeeeeeeeen CE, C-Tick and FCC Part 15

(Class A) Compliant

@ Note For EMC compliance, operate this device with shielded cabling.

CE Compliance
The SCXI-1600 meets the essential requirements of applicable European
Directives, as amended for CE marking, as follows:

Low-Voltage Directive (safety) ............. 73/23/EEC

Electromagnetic Compatibility
Directive (EMC) ......ccoevvveeieiiiiniecnee 89/336/EEC

E Note Refer to the Declaration of Conformity (DoC) for this product for any additional
regulatory compliance information. To obtain the DoC for this product, visit
ni.com/certification, search by model number or product line, and click the
appropriate link in the Certification column.
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Timing Signal Information

This appendix contains information about the timing signals discussed in
Chapter 3, Theory of Operation.

Connecting Timing Signals

Caution Exceeding the maximum input voltage ratings, which are listed in Table 2-2,
I/0 Signal Summary, can damage the SCXI-1600 module and the computer. Nl is not liable
for any damages resulting from such signal connections.

Timing connections are grouped into the following categories:
*  PFI connections
*  DAQ timing connections

*  General-purpose timing signal connections

PFIs are bidirectional pins. As outputs, they are not programmable and
reflect the state of many DAQ and general-purpose timing signals. As
inputs, the PFI signals are programmable and can control any DAQ and
general-purpose timing signals. All external control over the timing of the
SCXI-1600 module is routed through these two PFIs that are labeled PFI O
and PFI 7.

All digital timing connections are referenced to digital ground. This
reference is shown in Figure B-1, which shows an example of how to
connect an external AI START TRIG source and an external Al CONV
CLK source to two of the SCXI-1600 module PFI pins.
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Appendix B Timing Signal Information

PFI O/Al START TRIG

— — PFI 7/Al CONV CLK
I

Al START TRIG
Source

Al CONV CLK
Source

— D GND

1/0 Connector

/}V

SCXI-1600 Module

Figure B-1. Timing I/0 Connections

Programmable Function Input Connections

SCXI-1600 User Manual

There are a total of 13 internal timing signals that you can externally control
from the PFI pins. The source for each of these signals is software
selectable from any of the PFIs when you want external control. This
flexible routing scheme reduces the need to change the physical wiring to
the device I/O connector for different applications requiring alternative
wiring.

You can individually enable the PFI pins to output a specific internal timing
signal. For example, if you need the Al CONV CLK signal as an output on
the I/O connector, software powers on the output driver for the PFI 7/Al
CONYV CLK pin. Do not drive a PFI signal externally when it is configured
as an output.

When used as an input, you can individually configure each PFI for edge or
level detection, and for polarity selection. You can use the polarity selection
for any of the 13 timing signals, but the edge or level detection depends
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Appendix B Timing Signal Information

upon the particular timing signal being controlled. The detection
requirements for each timing signal are listed within the section that
discusses that individual signal.

In edge-detection mode, the minimum pulse width required is 10 ns. This
applies for both rising-edge and falling-edge polarity settings. There is no
maximum pulse-width requirement in edge-detect mode.

In level-detection mode, there are no minimum or maximum pulse-width
requirements imposed by the PFIs themselves, but limits can be imposed by
the particular timing signal being controlled.

Data Acquisition Timing Connections
The data acquisition timing signals are the following:
* AISTART TRIG
* AIREFTRIG
+ AISAMP CLK
* AICONV CLK
* AIGATE
* SISOURCE.

Posttriggered data acquisition allows you to view only data that is acquired
after a trigger event is received. Figure B-2 shows a typical posttriggered
data acquisition sequence. Pretriggered data acquisition allows you to view
data that is acquired before the trigger of interest in addition to data
acquired after the trigger. Figure B-3 shows a typical pretriggered data
acquisition sequence.

Al START TRIG [
Al SAMP CLK H |_| |_| |_| |_| ;
Al CONV CLK HU I | |

Scan Counter 4 '3 12 1 0

Figure B-2. Typical Posttriggered Acquisition
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Appendix B Timing Signal Information

Al START TRIG _l N S S N S S SR S
AIREFTRIG __ na 5 H

Al SAMP CLK 4ﬂ_ﬂ_ﬂ |—| |—|_,—|
Al CONV CLK i

ScanCounter 3 !2 1 0 2 ‘2 i2 1 !0

Figure B-3. Typical Pretriggered Acquisition

Al START TRIG Signal

SCXI-1600 User Manual

Any PFI pin can externally input the AI START TRIG signal.

Refer to Figure B-4 for the relationship of Al START TRIG to the data
acquisition sequence.

As an input, the AI START TRIG signal is configured in the edge-detection
mode. You can select any PFI pin as the source for Al START TRIG and
configure the polarity selection for either rising or falling edge. The
selected edge of the AI START TRIG signal starts the data acquisition
sequence for both posttriggered and pretriggered acquisitions.

Figure B-4 shows the input requirements for the AI START TRIG signal.

i tw i
Rising-Edge
Polarity — '
Falling-Edge
Polarity

ty = 10 ns minimum

Figure B-4. Al START TRIG Input Signal Timing

B-4 ni.com



Appendix B Timing Signal Information

The device also uses the Al START TRIG signal to initiate pretriggered
data acquisition operations. In most pretriggered applications, the

AI START TRIG signal is generated by a software trigger. Refer to the
AI REF TRIG signal description for a complete description of the use of
AI START TRIG and AI REF TRIG in a pretriggered data acquisition
operation.

Al REF TRIG Signal

Any PFI pin can externally input the AI REF TRIG signal.

Refer to Figure B-5 for the relationship of AI REF TRIG to the data
acquisition sequence.

As an input, the AI REF TRIG signal is configured in the edge-detection
mode. You can select any PFI pin as the source for Al REF TRIG and
configure the polarity selection for either rising or falling edge. The
selected edge of the AI REF TRIG signal initiates the posttriggered
phase of a pretriggered acquisition sequence. In pretriggered mode,

the AI START TRIG signal initiates the data acquisition. The scan
counter indicates the minimum number of scans before AI REF TRIG is
recognized. After the scan counter decrements to zero, it is loaded with the
number of posttrigger scans to acquire while the acquisition continues.
The device ignores the AI REF TRIG signal if it is asserted prior to the scan
counter decrementing to zero. After the selected edge of AI REF TRIG is
received, the device acquires a fixed number of scans and the acquisition
stops. This mode acquires data both before and after receiving

AI REF TRIG.
Figure B-5 shows the input timing requirements for the Al REF TRIG
signal.
i ty i
Rising-Edge
Polarity
Falling-Edge
Polarity
ty = 10 ns minimum

Figure B-5. Al REF TRIG Input Signal Timing
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Al SAMP CLK Signal

SCXI-1600 User Manual

Any PFI pin can externally input the Al SAMP CLK signal, which is
available as an output on the PFI 7/AI SAMP CLK pin.

Refer to Figure B-6 and Figure B-7 for the relationship of Al SAMP CLK
to the data acquisition sequence.

As an input, the Al SAMP CLK signal is configured in the edge-detection
mode. You can select any PFI pin as the source for Al SAMP CLK and
configure the polarity selection for either rising or falling edge. The
selected edge of the Al SAMP CLK signal initiates a scan. The sample
interval counter is started if you select internally triggered Al CONV CLK.

As an output, the AI SAMP CLK signal reflects the actual start pulse that
initiates a scan. This is true even if the starts are externally triggered by
another PFI. You have two output options. The first is an active high pulse
with a pulse width of 50 to 100 ns, which indicates the start of the scan. The
second action is an active high pulse that terminates at the start of the last
conversion in the scan, which indicates a scan in progress. Al SAMP CLK
deasserts to off after the last conversion in the scan is initiated. This output
is set to high-impedance at startup.

Figure B-6 and Figure B-7 show the input and output timing requirements
for the AT SAMP CLK signal.

1 tw 1

-~
Rising-Edge
Polarity
Falling-Edge
Polarity

ty = 10 ns minimum

Figure B-6. Al SAMP CLK Input Signal Timing
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D S EEE—— ]

Al SAMP CLK —— I
5 t, =50 to 100 ns 5

a. Start of Scan

Start Pulse _]

Al CONV CLK —

Al SAMP CLK _l

-

(

.

toff = 10 NS minimum

=¥

b. Scan in Progress, Two Conversions per Scan

Figure B-7. Al SAMP CLK Qutput Signal Timing

The AI CONV CLK pulses are masked off until the device generates the
AI SAMP CLK signal. If you are using internally generated conversions,
the first Al CONV CLK appears when the onboard sample interval counter
reaches zero. If you select an external Al CONV CLK, the first external
pulse after Al SAMP CLK generates a conversion. Separate the

AI SAMP CLK pulses by at least one scan period.

A counter on the SCXI-1600 module internally generates the

AI SAMP CLK signal unless you select an external source. This counter is
started by the AI START TRIG signal and is stopped either by software or
by the sample counter.

Scans generated by either an internal or external Al SAMP CLK signal are
inhibited unless they occur within a data acquisition sequence. Either the
hardware (Al GATE) signal or software command register gate can gate
scans occurring within a data acquisition sequence.
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Al CONV CLK Signal

SCXI-1600 User Manual

Any PFI pin can externally input the Al CONV CLK signal.

Refer to Figure B-8 for the relationship of Al CONV CLK to the data
acquisition sequence.

As an input, the Al CONV CLK signal is configured in the edge-detection
mode. You can select any PFI pin as the source for Al CONV CLK and
configure the polarity selection for either rising or falling edge. The
selected edge of the Al CONV CLK signal initiates an A/D conversion.

Figure B-8 shows the input timing requirements for the Al CONV CLK
signal.

Al SAMP CLK —— I
t,=251t0 50 ns

a. Start of Scan

Start Pulse _]

Al CONV CLK —

B

Al SAMP CLK _|

|

ey

toff = 10 NS minimum

=X

b. Scan in Progress, Two Conversions per Scan

Figure B-8. Al CONV CLK Input Signal Timing

The ADC switches to hold mode within 60 ns of the selected edge. This
hold-mode delay time is a function of temperature and does not vary from
one conversion to the next. Separate the Al CONV CLK pulses by at least
one conversion period.
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The sample interval counter on the SCXI-1600 module normally generates
the AICONV CLK signal unless you select an external source. The counter
is started by the Al SAMP CLK signal and continues to count down and
reload itself until the scan is finished. It then reloads itself in readiness for
the next Al SAMP CLK pulse.

A/D conversions generated by either an internal or external AL CONV CLK
signal are inhibited unless they occur within a data acquisition sequence.
Either the hardware (Al GATE) signal or software command register gate
can gate scans occurring within a data acquisition sequence.

Al GATE Signal

Any PFI pin can externally input the Al GATE signal. The AI GATE signal
can mask off scans in a data acquisition sequence. You can configure the
PFI pin you select as the source for the Al GATE signal in either the
level-detection or edge-detection mode. You can configure the polarity
selection for the PFI pin for either active high or active low.

In the level-detection mode, if AI GATE is active, the Al SAMP CLK
signal is masked off and no scans can occur. In the edge-detection mode,
the first active edge disables the Al SAMP CLK signal, and the second
active edge enables Al SAMP CLK.

The AI GATE signal can neither stop a scan in progress nor continue a
previously gated-off scan; in other words, once a scan has started, Al GATE
does not gate off conversions until the beginning of the next scan and,
conversely, if conversions are gated off, Al GATE does not gate them back
on until the beginning of the next scan.

S| SOURCE Signal

Any PFI pin can externally input the ST SOURCE signal. The onboard scan
interval counter uses the SI SOURCE signal as a clock to time the
generation of the ATl SAMP CLK signal. You must configure the PFI pin
you select as the source for the SI SOURCE signal in the level-detection
mode. You can configure the polarity selection for the PFI pin for either
active high or active low.

The maximum allowed frequency is 20 MHz, with a minimum pulse width
of 23 ns high or low. There is no minimum frequency limitation.
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Either the 20 MHz or 100 kHz internal timebase generates the STSOURCE
signal unless you select an external source. Figure B-9 shows the timing
requirements for the ST SOURCE signal.

tp =50 ns minimum
ty =23 ns minimum

Figure B-9. S| SOURCE Signal Timing
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Removing the SCXI-1600

This appendix explains how to remove an SCXI-1600 module from an
SCXI chassis and MAX.

Removing the SCXI-1600 from an SCXI Chassis

To remove the SCXI-1600 from an SCXI chassis, complete the following

steps:

1. Disconnect the USB cable running from the SCXI-1600 to the
computer or USB hub.

2. Power off the SCXI chassis. Do not remove the SCXI-1600 from a
chassis that is powered on.

3. Rotate the thumbscrews that secure the SCXI-1600 to the chassis
counterclockwise until they are loose, but do not completely remove
the thumbscrews.

4. Remove the SCXI-1600 by pulling steadily on both thumbscrews until
the module slides out completely.
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|1 Thumbscrews 2 SCXI-1600 3 Power Switch 4 SCXI Chassis

Figure C-1. Removing the SCXI-1600

Removing the SCXI-1600 from MAX

To remove the SCXI-1600 module from MAX, disconnect the USB cable
or power off the SCXI chassis. If the SCXI-1600 is still detected, press the
<F5> key.

@ Note When the SCXI-1600 is no longer detected in MAX, neither is the SCXI chassis in
which it is located along with the other modules in the chassis.

The SCXI-1600, SCXI chassis, and other SCXI modules are not
automatically removed from MAX when the USB cable is disconnected.
They still appear in the list, but have a red X indicating they are disabled.
If the USB cable is reconnected and the chassis is powered on, they are
again enabled and the red X is removed. To completely remove a module
or the entire chassis, right-click the module or chassis and then click
Delete.

The SCXI-1600 module is now removed from the list of installed devices
in MAX.
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Common Questions

This appendix contains answers to commonly asked questions about the
operation and special features of the SCXI-1600 module.

How do I know if my version of Windows supports USB?

Open the System properties in the Control Panel. Select the Hardware tab
and click the Device Manager button if a Universal Serial Bus Controller
along with a USB controller and a USB root hub are listed. If the computer
has this and USB ports, the computer supports USB. If the computer has
USB ports but no controller is listed in the Device Manager, you must
upgrade your software.

What is the best way to test the SCXI-1600 without having to program
the module?

The SCXI-1600 has no Test Panels, but you can perform a Test Chassis to
verify the presence of the SCXI-1600.

What do the different LED patterns on the front panel mean?

The top two green LEDs indicate whether you have power to the

SCXI chassis backplane while the bottom two LEDs indicate USB
communication. Refer to Table 1-1, LED Patterns for SCXI-1600 USB
States, for more information. If either of the top two green LEDs is off,
check the fuses in the back of the SCXI chassis.

What are PFIs, and how do I configure them?

PFIs are programmable function inputs. These lines serve as connections to
virtually all internal timing signals.

If you are using the NI-DAQ language interface or Measurement Studio,
use the Select_Signal function to route internal signals to the I/O
connector, route external signals to internal timing sources, or connect
internal timing signals.
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If you are using NI-DAQ with LabVIEW and you want to
connect external signal sources to the PFI lines, refer to the
Multi-Synch Shared Ext Sample Clk.vi asan example
of making these connections.

A Caution If you enable a PFI line for output, do not connect any external signal source to
it. If you do, you can damage the device, the computer, and the connected equipment.

SCXI-1600 User Manual

What are the power-on states of the PFIs?

At system power on and reset, the PFI lines are set to high-impedance by
the hardware. This means that the device circuitry is not actively driving the
output either high or low. However, these lines can have pull-up or
pull-down resistors connected to them as shown in Table 2-1, I/O
Connector Signal Descriptions. These resistors weakly pull the output to
either a logic high or logic low state. For example, PFI 0/AI START TRIG
is in the high-impedance state after power on, and Table 2-1 shows that
there is a 50 k€2 pull-up resistor. This pull-up resistor sets the

PFI 0/AI START TRIG pin to a logic high when the output is in a
high-impedance state.
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Symbol Prefix Value

p pico 10-12
n nano 102
u micro 10-6
m milli 10-3
k kilo 103
M mega 106
G giga 10°
T tera 1012

Numbers/Symbols

% percent

+ plus or minus

° degrees

/ per

+ positive of, or plus

— negative of, or minus

< less than

> greater than

< less than or equal to

> greater than or equal to
Q ohms

+5V +5 VDC source signal

© National Instruments Corporation G-1
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A
A
A/D
AC

ADC

ADC resolution

AI CONV CLK
Al GATE
AI SAMP CLK

amplification

ASIC

bipolar
BNC
buffer

bus

SCXI-1600 User Manual

amperes
analog-to-digital
alternating current

analog-to-digital converter—an electronic device, often an integrated
circuit, that converts an analog voltage to a digital number

the resolution of the ADC, which is measured in bits. A 16-bit ADC has a
higher resolution, and thus a higher degree of accuracy, than a 12-bit ADC.

convert signal
analog input gate signal
start scan signal

a type of signal conditioning that improves accuracy in the resulting
digitized signal and reduces noise

application-specific integrated circuit

bit—one binary digit, either O or 1

byte—eight related bits of data, an 8-bit binary number. Also used to denote
the amount of memory required to store one byte of data.

a voltage range spanning both positive and negative voltages
a type of coaxial signal connector
temporary storage for acquired or generated data (software)

the group of conductors that interconnect individual circuitry in a computer.
Typically, a bus is the expansion interface to which I/O or other devices are
connected.
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C

C

channel

channel clock

circuit trigger

clock

CMRR

code width

common-mode range

common-mode signal

common-mode voltage

conversion device

conversion time

convert clock

counter/timer

coupling

Glossary

Celsius

pin or wire lead to which you apply, or from which you read, an analog or
digital signal. Analog signals can be single-ended or differential. For digital
signals, channels are grouped to form ports.

the clock controlling the time interval between individual channel sampling
within a scan. Boards with simultaneous sampling do not have this clock.

a condition for starting or stopping clocks

hardware component that controls timing for reading from or writing to
groups

common-mode rejection ratio—a measure of the ability of a differential
amplifier to reject interference from a common-mode signal, usually
expressed in decibels (dB)

the smallest input voltage change that can be measured by a DAQ device
the input range over which a circuit can handle a common-mode signal

the mathematical average voltage, relative to the ground of the computer,
of the signals from a differential input

any voltage present at the instrumentation amplifier inputs with respect to
amplifier ground

device that transforms a signal from one form to another. For example,
analog-to-digital converters (ADCs) for analog input, digital-to-analog
converters (DACs) for analog output, digital input or output ports, and
counter/timers are conversion devices.

the time required, in an analog input or output system, from the moment a
channel is interrogated (such as with a read instruction) to the moment that
accurate data is available

clock signal used to increment to the next channel after each DAQ device
analog-to-digital conversion

a circuit that counts external pulses or clock pulses (timing)

the manner in which a signal is connected from one location to another
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D/A
D GND

DAC

DAQ

dB

DC

default setting

device

DIFF
differential input
digital port

DIO

dithering

SCXI-1600 User Manual

digital-to-analog
digital ground signal

D/A converter—an electronic device, often an integrated circuit, that
converts a digital number into a corresponding analog voltage or current

data acquisition—(1) collecting and measuring electrical signals from
sensors, transducers, and test probes or fixtures and processing the
measurement data using a computer; (2) collecting and measuring the same
kinds of electrical signals with A/D and/or DIO boards plugged into a
computer, and possibly generating control signals with D/A and/or DIO
boards in the same computer

decibel—the unit for expressing a logarithmic measure of the ratio of
two signal levels: dB = 20log10 V1/V2, for signals in volts

direct current

a default parameter value recorded in the driver. In many cases, the default
input of a control is a certain value (often 0) that means use the current
default setting. For example, the default input for a parameter may be do
not change current setting, and the default setting may be no AMUX-64T
boards. If you do change the value of such a parameter, the new value
becomes the new setting. You can set default settings for some parameters
in the configuration utility or manually using switches located on the
device.

a plug-in data acquisition board, module, card, or pad that can contain
multiple channels and conversion devices. SCXI modules are distinct from
devices, with the exception of the SCXI-1600, which is a hybrid.

differential mode

the two-terminal input to a differential amplifier
See port.

digital input/output

the addition of Gaussian noise to an analog input signal
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DNL

drivers/driver software

E

EMC
event

external trigger

F

FIFO

filtering

G

gain

gain accuracy
GATE input pin

grounded source

H

/0

ID

Glossary

differential nonlinearity—a measure in LSB of the worst-case deviation of
code widths from their ideal value of 1 LSB

software that controls a specific hardware device such as a DAQ device

electromechanical compliance
the condition or state of an analog or digital signal

a voltage pulse from an external source that causes a DAQ operation to
begin

first-in-first-out

atype of signal conditioning that allows you to remove unwanted frequency
components from the signal you are trying to measure

the factor by which a signal is amplified, sometimes expressed in dB
a measure of deviation of the gain of an amplifier from the ideal gain
a counter input pin that controls when counting occurs in your application

signal sources that are connected to ground

hertz—cycles per second of a periodic signal

input/output

identification
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in.

INL

input bias current

input impedance

input offset current

instrumentation
amplifier

K

kS

L

linearity

LSB

SCXI-1600 User Manual

inch or inches

integral nonlinearity—a measure in LSB of the worst-case deviation from
the ideal A/D or D/A transfer characteristic of the analog 1/O circuitry

the current that flows into the inputs of a circuit

the measured resistance and capacitance between the input terminals of a
circuit

the difference in the input bias currents of the two inputs of an
instrumentation amplifier

a very accurate differential amplifier with a high input impedance

kilo—the standard metric prefix for 1,000, or 103, used with units of
measure such as volts, hertz, and meters

1,000 samples

the adherence of device response to the equation R = KS, where
R =response, S = stimulus, and K = a constant

least significant bit

meters
(1) Mega, the standard metric prefix for 1 million or 10°, when used with

units of measure such as volts and hertz; (2) mega, the prefix for 1,048,576,
or 220, when used with B to quantify data or computer memory
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multiplexed mode

mux

NI-DAQ

nodes

noise

P

peak to peak

PFI
PGIA

Plug and Play devices

port

potentiometer

ppm

Glossary

an SCXI operating mode in which analog input channels are multiplexed
into one module output so that the cabled DAQ device has access to the
multiplexed output of the module as well as the outputs of all other
multiplexed modules in the chassis

multiplexer—a switching device with multiple inputs that sequentially
connects each of its inputs to its single output, typically at high speeds,
in order to measure several signals with a single analog-to-digital converter

the driver software needed in order to use National Instruments DAQ
devices and SCXI components

execution elements of a block diagram consisting of functions, structures,
and subVIs

an undesirable electrical signal—Noise comes from external sources such
as the AC power line, motors, generators, transformers, fluorescent lights,
soldering irons, CRT displays, computers, electrical storms, welders, radio
transmitters, and internal sources such as semiconductors, resistors, and
capacitors. Noise corrupts signals you are trying to send or receive.

a measure of signal amplitude; the difference between the highest and
lowest excursions of the signal

programmable function input
programmable gain instrumentation amplifier

hardware or software that after being installed can immediately be used,
as opposed to hardware or software that requires configuration

(1) a digital port consisting of multiple I/O lines on a DAQ device;
(2) a serial or parallel interface connector on a PC

an electrical device in which the resistance can be manually adjusted; used
for manual adjustment of electrical circuits and as a transducer for linear or
rotary position

parts per million
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Q

quantization error

R

relative accuracy

resolution

rise time

rms

S/s

sample clock

sample counter

scan

SCXI-1600 User Manual

the inherent uncertainty in digitizing an analog value due to the finite
resolution of the conversion process

a measure in LSB of the accuracy of an ADC. It includes all nonlinearity
and quantization errors. It does not include offset and gain errors of the
circuitry feeding the ADC.

the smallest signal increment that a measurement system can detect.
Resolution is expressed in bits, in proportions, or in percent of full scale.
For example, a system has 12-bit resolution, one part in 4,096 resolution,
and 0.0244% of full scale resolution.

the difference in time between the 10% and 90% points of a system step
response

root mean square—the square root of the average value of the square of the
instantaneous signal amplitude; a measure of signal amplitude

seconds
samples

samples per second—used to express the rate at which a DAQ board
samples an analog signal

the clock controlling the time interval between samples of all channels

the clock that counts the output of the channel clock, in other words, the
number of samples taken. On boards with simultaneous sampling, this
counter counts the output of the scan clock and hence the number of scans.

one or more analog samples taken at the same time, or nearly the same time.
Typically, the number of input samples in a scan is equal to the number of
channels in the input group. For example, one scan, acquires one new
sample from every analog input channel in the group.
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scan rate

SCXI
sensor

settling time

SI SOURCE
signal conditioning
software trigger

source impedance

STC

successive-
approximation ADC

switchless device

system noise

T

TC

THD
transducer

transducer excitation
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Glossary

the number of scans a system takes during a given time period, usually
expressed in scans per second

Signal Conditioning eXtensions for Instrumentation
a device that converts a physical phenomenon into an electrical signal

the amount of time required for a voltage to reach its final value within
specified accuracy limits

SI counter clock signal
the manipulation of signals to prepare them for digitizing
a programmed event that triggers an event such as data acquisition

a parameter of signal sources that reflects current-driving ability of voltage
sources (lower is better) and the voltage-driving ability of current sources
(higher is better)

system timing controller

an ADC that sequentially compares a series of binary-weighted values with
an analog input to produce an output digital word in n steps, where n is the
bit resolution of the ADC

devices that do not require dip switches or jumpers to configure resources
on the devices. See also Plug and Play devices.

ameasure of the amount of noise seen by an analog circuit or an ADC when
the analog inputs are grounded

terminal count
total harmonic distortion
See sensor.

a type of signal conditioning that uses external voltages and currents to
excite the circuitry of a signal conditioning system into measuring physical
phenomena
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trigger

TTL

u

USB

VDC

VI

W

wire

working voltage

SCXI-1600 User Manual

any event that causes or starts some form of data capture

transistor-transistor logic

universal serial bus

volts
volts direct current

virtual instrument—(1) a combination of hardware and/or software
elements, typically used with a computer, that has the functionality of

a classic stand-alone instrument; (2) a LabVIEW software module (VI),
which consists of a front panel user interface and a block diagram program

data path between nodes

the highest voltage with respect to ground that should be applied to an input
terminal during normal use, normally well under the breakdown voltage for
safety margin. Includes both the signal and common-mode voltages.
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A

accuracy information, A-2
acquisition sequences

posttrigger, 2-3

pretrigger, 2-3
active channels, 4-7
ACTIVE LED, 1-5, 2-2
AI CONV CLK signal, B-8
AI CONV CLK signal routing (figure), 3-4
AI CONV CLK signal timing (figure), B-8
AI GATE signal, B-9
AI REF TRIG signal, B-5
AI REF TRIG signal timing (figure), B-5
AI SAMP CLK input signal timing (figure), B-6
AI SAMP CLK output signal timing

(figure), B-7

AI SAMP CLK signal, B-6
AI START TRIG signal, 2-3, B-4
AI START TRIG signal timing (figure), B-4
amplifier characteristics specifications, A-3
analog input

specifications, A-1

theory of operation, 3-1
analog input mode. See differential mode
analyzing data, 4-5, 4-6
ANSI C. See Measurement Studio

block diagram, SCXI-1600 (figure), 3-1
BNC connectors, 2-1
buffer, FIFO. See FIFO memory
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C

calibration
constants, 4-9
EEPROM, 4-9
external calibration, 4-11
internal calibration
overview, 4-9
procedure for, 4-9
using LabVIEW, 4-10
using MAX, 4-10
specifications, A-5
system calibration, 4-11
C-based environment
programming. See developing your
application
channel sequencing, 3-5
channel strings, specifying in NI-DAQmx, 4-8
charge injection, 3-3
combination chassis compatibility note, 1-2
common questions, D-1
completing the application, 4-5
connecting signals, 2-3
connecting the SCXI-1600 to USB port or hub
(figure), 2-1
connectors
BNC, 2-1
signal descriptions, 2-3
table, 2-3
USB, 2-1
conventions used in the manual, iv

D

DAQ Assistant, 4-3
DAQmx, 4-7
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Index

DAQmx Channel Property Node, 4-6
using a DAQmx Channel Property Node
in LabVIEW, 4-7
DAQmx Clear Task VI, 4-7
DAQmx Create Task VI, 4-6
DAQmx Read VI, 4-6
DAQmx Self Calibrate VI, 4-10
DAQmx Start Task VI, 4-6
DAQmzx Stop Task VI, 4-7
DAQmzx Timing VI, 4-6
DAQ-STC, 1-1, 3-4
data analysis, 4-5, 4-6
developing your application
acquiring, analyzing, and presenting, 4-5
adjusting timing and triggering, 4-4
completing the application, 4-5
configuring channel properties, 4-5
creating a task using the DAQ Assistant or
Programmatically, 4-3
examples
LabVIEW, 4-3
LabWindows/CVI, 4-3
in LabVIEW, 4-5
specifying active channels, 4-7
in LabWindows/CVI, 4-8
in Measurement Studio, 4-9
in NI-DAQmx, 4-1
typical program flowchart (figure), 4-2
differential mode, 3-2
displaying data, 4-5, 4-6
documentation
conventions used in the manual, iv
National Instruments documentation, 1-3
dynamic characteristics specifications, A-3

E

edge-detection mode, B-3
electromagnetic compatibility
specifications, A-7
end-to-end calibration. See system calibration
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environmental specifications, A-6

error specifications, A-2

example finder, 4-3

examples
LabVIEW, 4-3
LabWindows/CVI, 4-3

EXT CAL signal, 2-3

external calibration, 4-11

F

FAQ. See common questions

FIFO memory, 3-6

finding examples. See example finder

first-in first-out memory, 3-6

flexible scanning, 3-5

frequently asked questions. See common
questions

front panel connectors, 2-2

G

gain, 3-2
getting started
items needed
documentation, 1-2
hardware, 1-2
software, 1-2
green LED, 1-5, 2-2

H

hot swapping caution, 1-1

I
input
gain, 3-2
mode. See differential mode
polarity, 3-2
range, 3-2
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selecting ranges, 3-3
input characteristics, specifications, A-1
installation, software, 1-4
internal calibration, 4-9

See also calibration

using LabVIEW, 4-10

using MAX, 4-10

L

LabVIEW
developing your application, 4-5
Example Finder, 4-3
programming a task (table), 4-6
using a DAQmx Channel Property Node
in LabVIEW, 4-7
using a while loop for continuous
sampling, 4-6
LabWindows/CVI, 4-8
developing your application, 4-8
Example Finder, 4-3
LEDs
green READY, 1-5, 2-2
pattern descriptions, 1-4
patterns for SCXI-1600 USB states
(table), 1-5
power, 2-2
yellow ACTIVE, 1-5, 2-2
level-detection mode, B-3
linearity specifications, A-2

MAX Test Panels, 2-4
maximum scan rate, calculating, 3-3
maximum working voltage, A-6
Measurement Studio, 4-9
developing your application, 4-9
examples, 4-4
measurements, calibrating SCXI-1600, 4-9
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Index

multiplexed mode
multiplexers, 3-5
note regarding SCXI-1600 operation, 2-4
theory of operation, 3-5

multiplexed operation. See multiplexed mode

N
NI-DAQ
required version, 1-4
specifying channel strings in
NI-DAQmx, 4-8
NI-DAQmx properties
configuring channel properties, 4-5
programmable NI-DAQmx properties,
4-9
noise, 2-5

P

PFI. See programmable function input
physical specifications, A-5
plug-and-play, 1-1
polarity, 3-2

selection, B-2
posttrigger acquisition sequences, 2-3
posttriggered

data acquisition, B-3

typical acquisition (figure), B-3
power LEDs, 2-2
power requirement specifications, A-5
precision, range and measurement (table), 3-2
pretrigger acquisition sequences, 2-3
pretriggered

data acquisition, B-3

typical acquisition (figure), B-4
program flowchart

discussion of typical program

flowchart, 4-3
typical flowchart, 4-1
figure, 4-2
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programmable function input, 3-5
PFI 0, 2-3
PF17,2-3
timing signal connections, B-2
programming. See developing your
application
properties
configuring channel properties, 4-5
NI-DAQmx programmable
properties, 4-9
property node, DAQmx Channel Property
Node, 4-6
pullup and pulldown resistor tolerance, 2-4

R

random scanning. See flexible scanning
range, 3-2

selecting input ranges, 3-3
range and measurement precision (table), 3-2
READY LED, 1-5, 2-2
regulatory compliance specifications, A-7
removing the SCXI-1600, C-1
resistor tolerance (table note), 2-4
resolution, A-1

S

safety specifications, A-6
SAMP CLK signal, 2-3
sampling rate, A-1
scan rate, calculating the maximum, 3-3
scanning
considerations, 3-3
flexible, 3-5
SCXI chassis, installing SCXI-1600, 1-4
SCXI-1600
about the module, 1-1
cabling between computer USB port or
USB hub (figure), 2-1
calibration, 4-9
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front panel connectors (figure), 2-2
installing, 1-4
module block diagram (figure), 3-1
multiplexed mode of operation, 2-4
programming. See developing your
application
removing, C-1
specifications, A-1
specifying channel strings, 4-8
taking measurements. See measurements
theory of operation, 3-1
selecting polarity, B-2
selection, 3-5
sequencing, channel, 3-5
settling time, 3-3
specifications, A-3
SI SOURCE signal, B-9
SI SOURCE signal timing (figure), B-10
signal summary (table), 2-4
signals
AI CONV CLK routing (figure), 3-4
AI CONV CLK signal, B-8
AI CONV CLK signal timing (figure),
B-8
Al GATE signal, B-9
AI REF TRIG signal, B-5
AI REF TRIG signal timing (figure), B-5
AI SAMP CLK input signal timing
(figure), B-6
AI SAMP CLK output signal timing
(figure), B-7
AI SAMP CLK signal, B-6
AI START TRIG, 2-3
AI START TRIG signal, B-4
AI START TRIG signal timing
(figure), B-4
connecting, 2-3
EXT CAL, 2-3
I/O connector description, 2-3
I/0O summary (table), 2-4
routing signal wires, 2-5
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SAMP CLK, 2-3
SI SOURCE signal, B-9
SI SOURCE signal timing (figure), B-10
timing signal routing, 3-4
software
application development environments
supported, 1-4
installation, 1-4
specifications
accuracy information, A-2
amplifier characteristics, A-3
analog input, A-1
calibration, A-5
dynamic characteristics, A-3
electromagnetic compatibility, A-7
environmental, A-6
error, A-2
input characteristics, A-1
linearity, A-2
maximum working voltage, A-6
physical, A-5
power requirement, A-5
regulatory compliance, A-7
resolution, A-1
safety, A-6
sampling rate, A-1
stability, A-4
transfer characteristics, A-2
triggers, A-4
stability specifications, A-4
system calibration, 4-11

T

taking measurements. See measurements
task creation, 4-3
Test Panels, MAX, 2-4
theory of operation, analog input, 3-1
timing
adjusting timing and triggering, 4-4
connecting timing signals, B-1
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data acquisition connections, B-3
data acquisition signals, B-3
I/O connections (figure), B-2
selecting polarity, B-2
signal information, B-1
timing signals, B-3
information, B-1
routing, 3-4
transfer characteristics, specifications, A-2
trigger specifications, A-4
triggering
adjusting timing and triggering, 4-4
specifications, A-4

u

USB connector, 2-1

v

VIs
DAQmx Clear Task VI, 4-7
DAQmx Create Task VI, 4-6
DAQmx Read VI, 4-6
DAQmx Self Calibrate, 4-10
DAQmx Start Task VI, 4-6
DAQmx Stop Task VI, 4-7
DAQmx Timing VI, 4-6

Visual Basic. See Measurement Studio

voltage ratings caution, 2-4

W

While Loop, 4-6
wiring considerations, 2-5

Y

yellow LED, 1-5, 2-2
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